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INTRODUCTION 
Rumen8 is a software application running on Microsoft Windows computers that allows farmers and 
consultants to easily manage dairy cow diets to increase production and reduce costs. It was originally 
developed by the staff of the Department of Agriculture and Food, Western Australia as an ‘in-house’ tool 
for managing the dairy herds on the Vasse Research Station near Busselton, Western Australia.  An 
emphasis on ease of use sets it apart from many other nutrition packages and it is this that makes it ideal 
for quickly creating or checking cow diets. 

Version 1 of Rumen8 was released free to the dairy industry and is used in Australia on research farms, by 
consultants and farm managers.  Its nutrition model is suitable for the pasture-dominated diets common 
across Australia. 

Rumen8 was given to the Western Australian dairy industry by the Department of Agriculture and Food in 
2014.  The new owners, Western Dairy and Dairy Australia, have provided funds to update it ensuring 
compatibility with contemporary versions of Windows and the addition of sought-after features to make 
the process of managing dairy diets even easier. 

WHAT DOES RUMEN8 DO? 

Rumen8 allows the user to design a diet from up to 15 feeds or mixes and ensure a cow’s dietary needs are 
met. Multiple diets can be stored and compared and if milk and feed prices are entered, the difference 
between feed price and return from milk calculated. 

Rumen8 uses a relatively simple nutrition model that we have found accurate enough over many years 
using it on farms and Research Stations. More sophisticated models of dairy cow nutrition exist but they 
require a higher level of user knowledge, depend on less readily available and more expensive feed 
analyses, and require more time to use. We have found that Rumen8 provides a good balance between 
ease and speed of use and performance that is fitting for the pasture-dominated dairy diets common in 
Australia. 

Dairy Australia have independently evaluated Rumen8 version 1 (many years before they owned it) against 
a range of nutrition models in use in Australia at the time and it performed admirably. You can read the 
report yourself as it is available from the Rumen8 and Dairy Australia web sites (A review of 11 applied 
dairy nutrition models used in Australia, 2009). The nutrition model in Rumen8 version 2 & 3 is unchanged 
from version 1. 

WHAT RUMEN8 DOESN’T DO 

Like most nutrition programs, Rumen8 works on a linear response to feeding. This means it assumes the 
same response to a kilogram of grain whether it is the first kilogram or the tenth kilogram fed to the cow. 
Due to this Rumen8 can be misleading when asking questions such as ‘What happens if I feed another 
kilogram of grain’ as it presents the average response for the first diet, and then the average response for 
the second diet that includes the additional feed. Rumen8 cannot be used to predict the response to just 
the last kilogram of additional feed. Generally, we would suggest halving the marginal response for grain. 
When Rumen8 calculates you would get an additional 2 litres of milk for an extra 1 kg of grain, we suggest 
you reduce the predicted milk response by half (in this case to 1 litre). 

  



 

A WARNING BEFORE YOU START 

Like any cow nutrition application, Rumen8 depends on a model of a cow that it ‘feeds’ and then estimates 
milk production and growth. No model is completely accurate and it is possible to create a balanced diet 
in Rumen8 that will reduce cow performance or even adversely affect their health. For this reason, we 
recommend Rumen8 is used with your nutritionist, and depending on your level of knowledge, between 
their visits to adjust diets. 

That statement leads us on nicely to the inevitable disclaimer. 

TERMS AND CONDITIONS 

While all reasonable efforts have been taken to ensure the accuracy of the Rumen8 application, use of the 
information it provides is at one’s own risk. To the fullest extent permitted by Australian law, Western 
Dairy, Dairy Australia and the developers disclaims all liability for any losses, costs, damages and the like 
sustained or incurred as a result of the use of or reliance upon the information provided, including liability 
stemming from reliance upon any part which may contain inadvertent errors, whether typographical or 
otherwise, or omissions of any kind. 

ACKNOWLEDGEMENTS 

Martin Staines and Richard Morris developed Rumen8 while they were employed by the Department of 
Agriculture and Food, Western Australia. The Western Australian Government gave Rumen8 to the 
Western Australian dairy industry. Thanks must go to the Board of Western Dairy for seeing value in it and 
providing a home and funds for development of subsequent versions.  
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WHAT’S NEW IN VERSION 3? 

• The number of diet ingredients has been increased from 10 to 15. 

• The window layout has been improved with important diet financial parameters always 
visible. 

• Feed mixes can be created and used in multiple diets as a single ingredient. 

• Animal demand and supply of the minerals calcium, phosphorous and magnesium has been 
included. 

• The feed library has been updated and expanded to over 250 feeds. 

• Diet DCAD is now calculated if ingredient DCAD is available. 

• Greatly expanded help and nutrition information is available via tooltips (hover the mouse 
pointer over an item to see them). 

• Four sets of recommended levels (early, mid or late lactation for example) can be set for 
important diet parameters by the user and then feedback is provided via traffic lights on 
the Diet tabs. 

• Notes about the current diet can be kept within Rumen8. 

• An expanded range of cost, margin and feed efficiency parameters are now calculated for 
each diet allowing better comparisons between diets. 

• ME and MP Detail windows can remain open while changes are made to the diet allowing 
easier monitoring of supply and demand calculations. 

• The Fat: Protein ratio and energy corrected milk have been added to the Animal tab. 

• The Forage: Concentrate ratio is now calculated for the diet. 

• Concentration and proportion units can be changed to percent by the user in the 
Preferences. 

• Multiple feed libraries are now supported.  

• The Optimiser now works with Microsoft Excel 2010, 2013 and 2016. 

• Animal activity has been simplified. 

• The standard cows have been expanded to include 9000 and 10000 litre lactations. 

• Changing animal values has been made faster and easier with sliders instead of input boxes. 

• Days in milk and days pregnant can now be set on a calendar. 

• Diets being compared can now have a description. 

• The dry cow period has been split into early and springer mobs. 

• Energy, protein and ingredient details are now accessible from the menu. 

• Feed and mix details are available by hovering the mouse over the ingredient name. 

• The traffic lights are now suitable for most colour blind users. 

• Diet ingredient amounts can be entered as fed or as dry matter. 

• The total diet weight is now displayed as fed and on a dry matter basis. 

• The Preferences can be reset to the default values. 

• The Preferences have been split into General and Advanced options. 

• Rumen8 is compatible with Windows 10. 

• Amino acids have been removed. 

• A saved diet file (.rm8) has been associated with Rumen8 so can be opened in Windows 
Explorer. 

• Rumen8 files are now databases so are independent of text file localisation. 

• Rumen8 version 2 diet files can be imported. 

• Updated User Guide and Training Manual along with a new Feed Companion. 



 

GETTING STARTED 
SYSTEM REQUIREMENTS 

Rumen8 requires the Microsoft Windows operating system to run.  This can be Windows Vista, 7, 8(8.1) or 
10.  It is recommended you have run Windows Update and installed all the updates recommended by 
Microsoft. 

If your computer can run Windows adequately, it will be sufficient to run Rumen8. The minimum screen 
resolution required to run Rumen8 comfortably is 1280 x 800 pixels. 

Rumen8 requires the Microsoft NET Framework version 4 or higher to be installed.  If your computer has 
been fully updated this will be installed automatically. 

UPGRADING FROM RUMEN8 VERSION 2 

Rumen8 version 3 can be installed on a computer that already has Rumen8 version 2 installed and they will 
run independently of each other and will not share library files. 

Rumen8 version 3 uses a new file format for diet, feed library, milk price and preference files (the old 
cow.csv file is now included in the preferences). Old diet and feed libraries can be imported into Rumen8 
from the File menu and in the Feed Editor. 

INSTALLATION 

The Rumen8 setup file can been downloaded from the Downloads page of the Rumen8 website at 
http://www.rumen8.com.au 

Once the executable file has been saved to your Downloads folder (the default Windows download 
destination) double click on the file in Windows Explorer to commence the installation process.  

 

Figure 1. The Windows 10 Downloads folder with the ‘Install Rumen8’ application ready to be run. 

 

  

http://www.rumen8.com.au/


Rumen8 User Guide | 8  
 

Windows SmartScreen problems with Windows 8 and 10 

Microsoft has added another layer of security to try and protect their users from malicious downloads. 
Unfortunately, it is not obvious what to do if you trust the downloaded file. The Rumen8 download may 
trigger a warning because it is from a software developer Microsoft do not recognise.  When you double 
click on the Rumen8 install executable a warning banner will appear across the centre of the screen. 

Figure 2. Windows 8 & 10 unknown software developer warning. 

 

 

Simply click on the ‘More info’ link and the option to run the installer anyway will appear. 

Figure 3. Run the installer anyway option exposed. 

 

 

Click on the ‘Run anyway’ button to continue installing Rumen8. 

 

 

  



 

Windows may ask for confirmation that you want to allow the following program from an unknown 
publisher to make changes to this computer.  
 

Figure 4. Windows user access control during Rumen8 installation. 

 

 

Click ‘Yes’ to continue the installation and the Rumen8 Setup Wizard will appear.  

 

Figure 5. The Rumen8 setup wizard. 

 

 

Click on the ‘Continue’ button to continue to the license agreement window. 
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Figure 6. The Rumen8 license agreement window. 

 

 

Read the Terms and Conditions and if you agree with them click on the ‘Accept’ button and move to the 
‘Important Instructions’ window. This covers the limitations of nutrition software like Rumen8 and suggests 
it should be used alongside your nutritionist to ensure no cow health or production issues arise from its 
use. 

Figure 7. The Rumen8 ‘Important Instructions’ window. 

 

 



 

If you agree click the ‘Continue’ button to choose the installation folder.  

Figure 8. The installation folder window. 

 

 

Use the ‘Browse’ button to change the installation folder if required.  The default folder will be suitable for 
almost everyone.  

Click on the ‘Install’ button to confirm installation. You may get a window open asking you to confirm the 
creation of the installation folder. Just click on ‘Yes’ to continue. 

  

Figure 9. Rumen8 is installing. 
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Figure 10. The installation is complete. 

 

 

Installation of Rumen8 is complete, click on the ‘Finish’ button to exit the installer and run Rumen8 for the 
first time. The installer also creates a Rumen8 icon on the Desktop so you can start it from there or in the 
Applications list of the Windows Start button.  

  



 

STARTING RUMEN8 FOR THE FIRST TIME 

Rumen8 can be started from the Start Menu of Windows Vista, 7 and 10 in the ‘All programs’ list. The 
Windows 7 start menu is shown in the figure below. Options to Pin the Rumen8 icon to the Taskbar, Start 
menu or Send a shortcut to the Desktop can be accessed by right clicking on the Rumen8 icon. 

 

Figure 11. Starting Rumen8 under Window 10. 

 

 

For Windows 8 users type ‘Rumen8’ while in the Modern tiled interface and options to install, run and read 
the Rumen8 User Guide will appear in the search window down the right of the screen. 
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Figure 12. Starting Rumen8 for the first time in Windows 8. 

 

 

To pin an icon to the tile interface and the Desktop so you can start Rumen8 without typing its name in the 
future, right click on the Rumen8 icon. Select ‘Pin to Start’ and/or ‘Pin to Taskbar’ to place the Rumen8 icon 
in these locations. 

Figure 13. Pin the Rumen8 icon to the Start bar and Taskbar. 

 

 

Finally, left click on the Rumen8 icon to start the application.  



 

When Rumen8 starts for the first time it will ask you where to create a Rumen8 folder into which will be 
placed a Libraries folder with your copy of the feed library, preferences and milk prices files. Copying these 
files may take a few minutes so the first time you run Rumen8 it will take a little longer to get to the main 
window than normal. 

Figure 14. Choose the location of the Rumen8 folder. 

 

 

Your Documents folder is the recommended location as this is easy to access and is more likely to get 
backed up. If you are happy with the default location click the ‘Yes’ button but if you would like another 
location for the Rumen8 folder click ‘No’. This will take you to a folder browser where you may specify the 
location yourself. 

Rumen8 will then create a folder called ‘Rumen8’ at the chosen location and within it another folder called 
‘Libraries’.  In this folder will be copied a feed library, preferences and milk prices file used by the application 
for this user. If multiple users use the computer, each user will have their own copy of the Rumen8 library 
files and can tailor Rumen8 for their own requirements. 

If a folder called ‘Rumen8’ already exists in the location you have chosen it will be used and no files will be 
deleted. If a ‘Libraries’ folder already exists within the Rumen8 folder it will also be used.  If you already 
have the library files from a previous installation in the Libraries directory they will be left untouched and 
the defaults not copied from the application folder. In this way you can remove and reinstall Rumen8 
manually and your feed library and settings will remain. 

If you wish to revert to the default original version of any of the library files just delete them and then start 
Rumen8 and it will offer to copy a new file as a replacement. 

The Rumen8 folder is the recommended location for your saved diet files. 

The main Rumen8 window will now open ready for use. 
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REGISTERING RUMEN8 

When Rumen8 is run for the first time it will start in trial mode.  This allows you to use all the functions of 
the application but you are restricted to diets with only two ingredients. To get full access to all the diet 
ingredients please register, which is free. We ask you to register so we have an estimate of the number of 
people using the application. This information will be used for future funding applications for further 
development. By not registering or if you share your registration name and number you may reduce the 
chance of future improvements to Rumen8. 

To register send an email to support@rumen8.com.au specifying the name you would like to register and 
the email address you would like to be contacted on if it is different to the one used to send the email.  
Your email will only be used to contact you for registration purposes and very infrequently for matters 
concerning Rumen8 in the future.  It will not be passed on to any other person or group. You should receive 
a registration email within 48 hours containing a registration code that is linked to your name. 

If you go to the Registration option under the Help menu you can enter your name and registration number 
exactly as specified in the email from Rumen8 support. The best way to be sure you have entered them 
exactly is by using copy (control-c) and paste (control-v) to copy them from the email and then paste them 
into Rumen8. Click the ‘Register’ button and all the feed ingredients will become available. 

Figure 15. Entering registration details. 

 

 

REMOVING YOUR RUMEN8 REGISTRATION 

If you plan to give you computer to someone else, before uninstalling Rumen8 go to the Registration option 
under the Help menu and click the ‘Deregister’ button.  Your name and registration code will be removed 
from the machine and Rumen8 will revert to trial mode.  

mailto:support@rumen8.com.au


 

QUICK START GUIDE 
Start Rumen8 and the main screen will open. If you are unsure what something within Rumen8 is, hover 
your mouse over it and for most objects a tooltip will appear providing a more detailed explanation. 

The Rumen8 window is shown below and is divided into 3 sections. The Diet Ingredients section where you 
specify the animal diet (1), the tabbed section where you can specify the cow details, evaluate the current 
diet, adjust feed costs and milk payments, compare alternative diets and keep notes (2) and the bottom 
costs and efficiency strip that reports feed costs, milk income, feed efficiency and margins (3). 

 

Figure 16. The sections of the main Rumen8 window. Diet ingredients (1), detail tabs (2) and diet costs and 
efficiencies (3). 

 

 

Click on the ‘Animal’ tab to show the cow description.  

 

DESCRIBE A COW 

Using the entry sliders describe the cow you wish to feed, or the average cow that represents your herd. 
You can adjust live-weight, growth rate, milk yield and components, stage of lactation and number of days 
pregnant. Less important parameters let you adjust the activity level of the cow if you have a large or hilly 
farm.  
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Figure 17. The Animal tab. 

 

 

Now click on the ‘Diet’ tab to the right of the ‘Animal’ tab to view how well our diet will feed the cow. It 
doesn’t show anything as we have not added any ingredients to the diet. 

 

Figure 18. The Diet tab. 

 

 



 

ENTER A DIET 

Fifteen ingredients can be added to a diet using the drop-down lists on the left of the window. Click on 
ingredient 1 and select ‘Barley grain’ as our first feed in the diet. 

Figure 19. Selecting a feed in the first diet component menu. 

 

Select ‘Lupins grain’ for ingredient 2 and ‘Ryegrass – Dryland – late annual’ in ingredient 3. The diet should 
now look like the figure below. 

Figure 20. Three ingredients in the diet. 
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Now let’s feed our cow. Enter the amount of each ingredient fed to the cow using the ‘DM’ entry box to 
the right of their name. Enter 6 kilograms of barley grain, 3 kilograms of lupins grain and 10 kilograms of 
ryegrass. The window should now look like the figure below. 

 

Figure 21. Feeding our cow. 

 

 

EVALUATE A DIET 

The ‘Diet’ tab shows nine of the parameters you need to consider when formulating a diet for dairy cows. 
For this example we will consider the first three. With the current diet, we can see there is insufficient 
metabolisable energy (ME 91%) and protein (MP 92%) for the cow we described earlier. However, the 
cows’ dry matter intake is only 86% of her potential so this means she can physically eat more food if it is 
presented to her. 

Increase the amount of barley grain to 8.3 kg, the lupins to 3.7 kg and decrease the ryegrass to 8.2 kg. Now 
you will see both ME and MP are at 100% of the cow requirement and intake potential is still below 100% 
so she can eat this amount of feed. Your screen should look like the figure below. 

 



 

Figure 22. A diet balanced for energy and protein. 

 

 

This brings us to a very important point that is true of all nutrition models. The application tells us we have 
a diet that meets the ME, MP and intake requirements of our cow, but a nutritionist is unlikely to 
recommend this particular diet.  The starch content and the proportion of the diet that is highly digestible 
concentrate are high (25% and 59% respectively) leading to a risk of acidosis.  That is before we consider 
the lost production from feeding our cows less than they can eat.  

 

Rumen8 is a tool that will assist someone with nutritional knowledge to better and more cost effectively 
feed their cows, but in the hands of someone without that knowledge it can create diets that appear 
balanced on paper but may decrease cow performance or adversely affect their health.  

We recommend Rumen8 is used with your nutritionist and depending on your level of knowledge, used to 
adjust diets between their visits. 

 

This diet is now balanced for energy and protein and the cow can physically eat the feed when it is 
presented to her.  This demonstrates the process when designing a diet for your cows, and you can now 
further refine the diet by looking at other important parameters such as starch and NDF content. More 
information about the current diet is presented in the ‘Diet detail’ tab. 

The remaining tabs allow you to change milk payment (‘Milk price’ tab) and the cost of the feeds in the 
current diet (‘Feed cost’ tab). With feed costs and milk price Rumen8 can show you diet costs and margins 
to better compare alternatives. Use the ‘Compare’ tab to save and compare related diets before choosing 
the best one. The ‘Notes’ tab allows you to keep a description of the diet for reference in the future. How 
to use these functions is detailed in ‘Using Rumen8’ section of this document. 
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THE PROBLEM OF MEASURING PASTURE INTAKE 

It all sounds simple, choose the ingredients your cows are being fed, enter the quantities you provide and 
balance the diet.  Easy, but what about grazed pasture? Accurately measuring how much grazed pasture a 
cow eats is very expensive and time consuming so may not be done on farm. To solve this problem, we 
‘back calculate’ how much pasture the cows are eating by subtraction of all the ingredients you do know. 
It is easier than it sounds. 

1. Enter the values that describe the average cow in your herd on the ‘Animal’ tab. Include the current 
milk production and yield. Rumen8 will calculate the metabolisable energy needed for the cow and 
this is displayed on the ‘Diet’ and ‘Diet detail’ tabs. 

2. Add all the supplementary feed provided to the cows to the Diet ingredients drop-down lists. This 
includes grain fed in the dairy and forages in the paddock. Everything except grazed pasture. 

3. Rumen8 now calculates the metabolisable energy provided by the supplements and the difference 
between this and the cow’s requirement must be supplied by grazed pasture. This is shown on the 
‘Diet detail’ tab as the ‘Balance’ under the ‘Metabolisable energy’ section and the remaining 
percentage of the metabolisable energy bar on the ‘Diet’ tab. 

4. Select a suitable pasture for your farm and time of year and as the next diet ingredient. Increase 
the quantity of this until the metabolisable energy provided by the diet is the same as the 
requirement of the cow. 

You now have the diet that reflects the current situation with an estimate of the amount of pasture each 
cow is eating. With this information you can explore alternative diets that include pasture assuming you 
will maintain the amount of pasture on offer for the herd in the future. 

  



 

MENU COMMANDS 
The menu is along the top of the main window and has five choices, File, Edit, Animal, View and Help. 

FILE MENU 

Figure 23. The File menu. 

 

 

Open Allows you to load a previously saved diet. 

Save Save the current diet. This is only available if the diet has been previously named and 
saved using the ‘Save As’ menu. 

Save As Name and then save the current diet. If changes to the current diet have not been saved 
an * will appear next to the diet name in the title bar. 

Reload feeds  This updates all the feed data from the feed library. This is useful if you have multiple 
instances of Rumen8 running and have made a change to a feed in one of them and wish 
to quickly update the others. 

Import This will import a Rumen8 version 2 diet file. 

Preferences Opens the Preferences allowing you to change Rumen8 settings. A more detailed 
explanation is given in the Preferences section. 

Exit Close Rumen8. You will be prompted to save an unsaved diet. 
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EDIT MENU 

Figure 24. The Edit menu. 

 

 

Copy diet Copy the current diet to the clipboard for later pasting into Excel or Word for example. 

Copy all diets Copy the current diet and the three stored diets to the clipboard. 

Edit feeds Opens the Feed Editor to change feeds and mixes and the ingredients available in the 
ingredient drop-down lists. A more detailed explanation is given in the Feed Editor 
section. 

 

 

  



 

ANIMAL MENU 

Figure 25. The Animal menu. 

 

 

Save current animal as the default Save the current animal as the default that will be loaded each 
time Rumen8 starts. 

Reload default animal Replace the current animal with the default animal. 

Use standard animal Replace the current animal with a pre-defined generic cow in 
early, mid or late lactation for total lactation production of 
5000 to 10000 litres. These definitions should only be used for 
general analyses. For on-farm use actual milk production and 
composition for the herd of interest should be used. 

Dry off the current animal Change the parameters for the current animal as if it had been 
dried off and was mid-way through a 65-day dry period. 

Move current animal into ‘springer’ mob Change the parameters for the current animal to one that is 2 
weeks prior to calving and has entered ‘transition’. 
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VIEW MENU 

Figure 26. The View menu. 

 

 

Energy detail Displays the details of the metabolisable energy demand calculated for the animal. 

Protein detail Displays the details of the metabolisable protein supply and demand calculated for 
the animal. 

Minerals detail Displays the details of the calcium, phosphorus and magnesium demand and supply. 

Ingredient detail Displays the details of the diet ingredient. 

 

  



 

HELP MENU 

Figure 27. The Help menu. 

 

 

Check for updates Check to see if a newer version of Rumen8 is available. This can only be done if your 
computer is connected to the Internet. 

About Display information about Rumen8 such as the version number, website address and 
email for support. 

Registration Enter your registration number and name here to unlock all the diet ingedients. 
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USING RUMEN8 
This section will describe the main parts of the Rumen8 window and how you use them. 

DIET COMPONENTS 

The left section of the main window is where you add ingredients to your diet and specify the quantity fed 
each day. In the figure below it is highlighted within a blue rectangle. 

Figure 28. The diet ingredients section of the main window shown within the blue rectangle. 

 

 

Clicking on the down arrowhead to the right of the drop-down lists you can choose any of the feeds 
available from the feed library. Once a feed has been selected the ‘DM’ and ‘As fed’ entry box becomes 
active and you can either type the kilograms to be fed in directly or click on the up and down buttons to 
vary the existing amount. 

You can enter the value on a dry matter basis in the ‘DM’ column and the amount will be displayed on an 
as fed basis in the ‘As fed’ entry box. If you prefer to enter the amount as fed the reverse works in the same 
manner. Internally Rumen8 always uses the value on a dry matter basis. 

Up to fifteen feeds or mixes can be added to a diet. To see the details of a selected ingredient, click on the 
ingredient number and the detail window will open. Alternatively hover the mouse over ingredient name 
and a tooltip will appear showing the feed or mix attributes. 

The total diet weight on a dry matter basis and as fed are displayed at the bottom of each of the columns. 



 

Figure 29. The diet ingredient detail window. 

 

 

Figure 30. The diet ingredient tooltip window. 

 

 

As feeds are added or quantities are adjusted Rumen8 recalculates energy and nutrient supply relative to 
energy and nutrient demand, thus showing the adequacy of your diet in meeting production objectives. 
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ANIMAL 

The Animal tab is the first of the tabbed section of the main window and is used to describe the cow, or 
the cow that represents the herd average, for the diet that we are creating. 

Figure 31. The Animal tab highlighted in the blue rectangle. 

 

 

Using the sliders adjust live weight, growth rate, milk yield and components, days pregnant and days in 
milk.  The value can be changed quickly by moving the slider left and right or adjusted 1 unit at a time by 
clicking on the – and + symbols at either end. 

Days pregnant and days in milk can also be set by specifying the date of conception or calving by clicking 

on the calendar icon  . 

For convenience, the milk yield is also expressed as fat: protein ratio and fat plus protein kilograms per day 
based on the input milk yield and components. The energy corrected values display the yield in kg corrected 
to the international standard 4.0% m/m fat and 3.3% m/m protein. 

Additional parameters let you adjust the activity level of your cows if you have a large or hilly farm.  Note 
that a grazing cow will typically walk 4-5 km over a day in the paddock, in addition to the distance to and 
from the dairy for milking 

Breed 

The cow breed is used to estimate mineral demand and has a relatively small influence so don’t worry too 
much if your actual breed is not an option. Choose the closest related breed. 

Live weight  

Mean live weight (kg) of the herd of interest at the time of interest.  If unknown, use the following as a 
guide. 



 

“North American” Holstein cows are 600-650 kg live weight. 
Australian Friesian cows are 550-600 kg live weight. 
Cross-bred cows 450-500 kg live weight. 
Jersey cows 375-425 kg. 
First calvers are 10-20% less than their mature counterparts. 

Cows that are weighed on farm are the best guide. 

For culled cows that are sold ‘over the hooks’, dairy cows typically dress out at ~40-45% of live weight. 
For example, a 260-290 kg dressed weight equates to ~650 kg live weight. Note that cull cows are (or 
should be) older cows, so these may not be representative of the average live weight of the herd. 

Live weight change  

This is the estimate of the amount of live weight that is being lost across the herd (kg/cow/day).  Some 
typical figures are shown below. 

Figure 32. Typical estimates of live weight change during a lactation. 
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Days Pregnant 

Affects nutritional requirements, which becomes significant from 140 days onwards.  Days Pregnant 
should be the weighted average of the herd (see below example of Days in milk). The number of days 
since conception can be entered directly with the slider or click on the calendar icon to select the date of 
conception. 

Days in milk 

Days in milk (DIM) is also required to estimate feed intake potential, as stage of lactation influences the 
amount of feed a cow can consume.  Feed intake (kg DM/cow/day) is estimated as per NRC (2001).  
Peak dry matter intake (DMI) generally occurs at 80-100 days post calving. Where cows have been 
exceptionally well prepared for calving and then well fed post calving without any metabolic or health 
issues peak DMI may occur 60-80 days.  
Where cows have had restricted energy intake through this period peak DMI is more likely to be 100-120 
days. 
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Days in milk must be calculated as a weighted average for the herd. For example 
100 cows @ 100 DIM =  10,000 cow days 
200 cows @ 280 DIM =  56,000 cow days 
30 cows @ 350 DIM =  10,500 cow days 
330 cows 76,500 cow days 
Weighted herd average = 76,500 cow days / 330 cows = ~230 DIM 

The number of days since calving can be entered directly with the slider or click on the calendar icon to 
select the (mean) calving date. 

Number of cows in the herd 

This is used only to calculate the herd margin (daily milk income minus daily feed costs in $/herd/day) and 
can be left set to 1 if you are more interested in daily milk income minus daily feed costs per cow/day. 

Milk fat and protein 

Ensure you set the correct unit in “preferences”: in Australia this is almost always mv%, while in NZ it is 
mm%.  Protein% is true protein (in some countries it is analysed as crude protein which is about 6% higher 
than true protein). Take the average of the latest 5 days of available factory figures. When estimating 
production for groups of cows within the milking herd the milk fat and protein %’s are likely to be 
significantly different to the herd average e.g. early lactation cows at peak production vs late lactation 
cows. 

Milk yield 

(litres or kilograms/cow/day) – if milking numbers are stable this should be the last 5-10 days average milk 
yield per cow. Yield should include all milk produced per cow, including milk that is being fed to calves and 
milk not suitable for consumption. 

Distance walked 

This influences the amount of energy required for maintenance.  

Cows grazing a large farm (300 Ha) with centrally located dairy will on average walk 4 km to and from the 
dairy plus distance walked while grazing ~5 km. Daily total 9 km. 

Cows grazing a medium sized farm (150 Ha) with centrally located dairy will on average walk 3 km to and 
from the dairy plus distance walked while grazing ~4 km.  Daily total 7 km. 

Cows grazing a smaller sized farm (75 Ha) with centrally located dairy will on average walk 2 km to and 
from the dairy plus distance walked while grazing 3 km. Daily total 5 km.d 

Farm terrain 

This influences the amount of energy required for maintenance. Note that walking 1 ‘vertical meter’ 
requires the same energy as walking 10 ‘horizontal meters’. 
 

 

 

 

  



 

DIET 

The diet tab provides an overview of the current diet performance. It is highlighted within a blue rectangle 
in the figure below.  

Figure 33. The Diet tab. 

 

 

The Diet tab has six horizontal bars representing the dry matter intake, metabolisable energy (ME), 
metabolisable protein (MP), calcium, phosphorus and magnesium in the diet. Below these are the neutral 
detergent fibre (NDF) and starch percentage of the diet and the forage to concentrate ratio. 

Metabolisable energy, protein and minerals are expressed as a percentage of the cow’s requirement so a 
balanced diet should have these parameters around 100%. When the cow’s requirement is not being met 
the progress-bar will be red. When the diet meets the cow’s requirement the bar will be green. If there is 
an excess of ME, MP or minerals in the diet the corresponding bar will be yellow. 

The intake bar shows the percentage of the animal’s maximum intake the current diet represents.  When 
the cow is eating to potential the bar will be green. If the diet contains too much feed for the cow to eat 
the bar will turn yellow and if the cow is being underfed the bar will be red. 

How close to 100% progress bars must be to turn green is set in the preferences. 

The starch and NDF bars show the percentage of the diet made up of these components. The final value 
show the ratio of forage to concentrate in the diet.  

If recommended levels are set for NDF, starch and forage: concentrate a traffic light will appear and show 
whether the current value is under, within or above the recommended range. See the preferences section 
for how to set recommended levels. Independent of the recommended levels a warning may appear next 
to each of these parameters if the dietary level suggests the cow may be in danger of ruminal acidosis.  
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DIET DETAIL 

The ‘Diet Detail’ tab is used in a similar way to the ‘Diet’ tab, but contains much more information about 
the diet performance. 

Figure 34. The Diet Detail tab shown within the blue rectangle. 

 

 

The diet detail tab is divided into several sections covering metabolisable energy, metabolisable protein, 
dry matter intake, fibre, rumen protein, starch, fat, minerals and DCAD. In addition, the active set of 
recommended levels can be changed in the bottom left corner of the tab. 

Metabolisable energy  

This section shows the total ME supplied by the diet, demand from the cow and the consequent balance. 
Below is the energy density of the diet. 

The ‘traffic light’ to the right is red when ME from the diet is insufficient, green when it meets the cows 
demand and yellow when it exceeds the cow’s needs. Clicking on the title ‘Metabolisable Energy’ (or the 
menu option View, Energy detail) will bring up the detail window that provides more information about 
the energy model used by Rumen8 and how ME demand is calculated. The detail window can remain open 
while the diet and cow is adjusted so the influence on components of the total ME demand can be seen. 



 

Figure 35. The metabolisable energy detail window. 

 

 

Metabolisable protein  

This section shows the total MP supplied by the diet, demand by the cow and the subsequent balance. 
Below is the diet’s crude protein content. Crude protein content of the total diet is only provided for 
reference. The ‘traffic light’ to the right is red when MP from the diet is insufficient, green when it meets 
the cow’s requirement and yellow when it exceeds the cow’s needs. Clicking on the title ‘Metabolisable 
protein’ (or the menu option View, Protein detail) will bring up the MP supply and demand detail window 
that provides more information about the protein model used by Rumen8. The detail window can remain 
open while the diet and cow is adjusted so the influence on components of the total MP supply and demand 
can be investigated. 

As with the rest of the Rumen8 application, hovering the mouse over each parameter will provide 
additional explanatory information. If you hover over the text ‘MP system flowchart’ on the detail window 
a chart will appear that shows the path protein takes through the animal that corresponds to the values 
Rumen8 calculates when estimating MP supply. 
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Figure 36. The metabolisable protein detail window. 

 

 

Intake  

The intake section shows the dry weight of the current diet and the percentage of maximum intake this 
weight represents for two methods of calculating intake potential. It is recommended you refer to the NRC 
DMI%, as we suggest this is more reliable than determining intake potential by calculating NDF intake as a 
percentage of live weight for lactating cow diets that contain concentrates. 

The ‘traffic light’ is red when the diet constitutes less than the cow can eat, green when the cow is eating 
as much as she can, and yellow when the diet exceeds the cow’s ability to eat it. The current intake estimate 
method linked to the traffic light is shown in black text and the other in grey. The sensitivity of the traffic 
light and which method to use for intake estimation can be adjusted in the preferences. 

 



 

Fibre, rumen protein, starch and fat 

The four sections in the top right of the diet detail tab reports a range of diet parameters for the current 
diet. These cover things like NDF, starch and sugar through to rumen degradable protein and forage 
concentrate ratio. If you are unsure what one of the abbreviations means hover your mouse over the text 
and a tooltip will appear with a more detailed explanation. 

The ‘Excess protein’ section shows the effect of having too much protein in the diet. There is a metabolic 
cost to remove the additional protein and this is expressed as forgone milk production or live weight 
growth. The calculation can be adjusted in the preferences. 

If recommended levels have been set for some of these diet parameters a small traffic light appears next 
to the value and shows if it is below, within or above the recommended range. In addition, the NDF, starch 
and forage concentrate ratio may show a red exclamation mark if the current value may result in the animal 
being at high risk of ruminal acidosis. 

Minerals 

The bottom right section of the diet detail tab displays supply and demand for the diet’s calcium, 
phosphorus and magnesium levels. A traffic light for each shows if the current level is below (red), equal to 
(green) or above (yellow) the animal’s requirement. If all the feed ingredients have a DCAD value the dietary 
DCAD is calculated and compared with a recommended level depending on whether the cow is lactating, 
in the early dry period or the ‘springer’ herd. 

Clicking on any of the titles ‘Calcium’, ‘Phosphorus’ or ‘Magnesium’ (or the menu option View, Minerals 
detail) will bring up the Minerals supply and demand detail window that provides more information about 
the animal demand and diet supply of each of the minerals. The detail window can remain open while the 
diet and cow is adjusted so the influence on mineral supply and demand can be investigated by adjusting 
cow or dietary parameters. 
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Figure 37. The minerals detail window. 

 

 

Recommended levels 

The section in the bottom left of the diet detail tab shows which set of recommended levels has been 
selected, if any, and allows the user to change between sets. In the figure above a set of recommended 
levels that applies to early lactating cows has been selected and the small traffic lights are linked to this. 
See the preferences section for how to turn on and off and adjust the recommended levels.  



 

MILK PRICE 

The price of milk is used to calculate milk income and margins of milk income over feed costs. A total of 24 
milk prices can be entered as two sets of 12 prices. One set of twelve prices is entered as payment by 
volume and the other set as payment for components.  

Which set of prices is used by Rumen8 is determined by the ‘Payment’ box to the right of the tab. Click on 
the ‘Components’ button to use the 12 payment prices entered as payment for fat plus protein minus a 
volume discount, or the ‘Volume’ button to select the 12 volume prices entered as cents per litre. 

Figure 38. The milk price tab with payment by volume selected. 
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Figure 39. The milk price tab with payment by components selected. 

 

 

If the payment is entered by volume, the equivalent value expressed as payment for components is shown 
alongside it, and if by components, the equivalent shows the price calculated by volume. The calculation 
of equivalent price uses the current milk components entered on the animal tab. 

Each of the 12 prices are entered in the entry box/s alongside the numbers 1 to 12. The current price is 
selected with the button to the left of the number.  



 

FEED COST 

The feed cost tab allows you to quickly adjust feed prices and losses for feeds in the current diet without 
returning to the feed library. This is useful for comparing groups of feed sources at different prices without 
having to create a new feed for each. 

Figure 40. The feed costs tab. 

 

 

For each of the current diet feed ingredients you may change the cost on a dry or as fed basis and the 
losses that occur before the cow eats it. The final cost is expressed on a dry matter basis, and then after 
losses for both dry and wet weights. 

The new values are changed in the feed library so if you are investigating the influence of feed price changes 
don’t forget to put the actual feed cost back when you have finished. 

Losses are not applied to the amount of feed eaten by the animal, but represent the amount of feed lost 
from when it was costed (usually at delivery or harvest) and when it is eaten. This means the losses only 
influence the feed cost, not the feed amounts. For example, if the barley grain in the figure above costs 
$250/t DM delivered to the farm and losses are set to 2%, it means the loss occurs after the grain was 
delivered to the silo and before the cow eats it. The cow still eats 8.30 kg/day of barley grain. 

The diet ingredient amounts are always the amount the animal eats, regardless of losses. 
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COMPARE 

The ‘Compare’ tab allows you to build a diet and then save it for comparison with other diets. Think of it as 
three slots where you can put away a diet while you experiment with other feeds in the main window and 
then compare them before recalling the best one.  

Figure 41. The compare tab. 

 

 

There is room for three diets numbered 1, 2 and 3 from left to right. To store the current diet click the ‘S’ 
button (store) for one of the diet slots. The 15 ingredients that make up the diet will appear in the slot 
along with important parameters below. You can make changes to the current diet, store an additional two 
versions, decide which offers the best solution and then recall that one to the main window by clicking the 
‘R’ button (recall) for that slot. Clicking the ‘C’ button (clear) will empty the slot. 

  



 

NOTES 

The notes tab allows you to write anything about the current diet you may wish to remember when looking 
at it later. This is often useful if you save diets by date and then refer to them in later years for guidance. 
The notes can also be used to communicate with your nutritionist if you can save the diet file and email it 
to them for comment or adjustment. 

Figure 42. The notes tab. 
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OPTIMISE (ADVANCED USERS) 

The Optimise function within Rumen8 is not supported, as the setup is difficult unless you have a good 
knowledge of Microsoft Windows and Excel. It requires Microsoft Excel and the Solver add-in to be installed 
(versions 2013 or 2016) and configured for use with Rumen8. See the Optimiser Installation section for 
details. 

The Optimise tab and button will only be available if it is enabled in the Rumen8 Preferences. Optimising 
allows you to fine tune a diet to minimise cost.  The optimiser will vary the amount fed of each ingredient 
to find the cheapest diet that meets the constraints you have chosen. Using the optimiser requires all feeds 
have costs entered in the fed library or the feed costs tab. 

You should first add your feeds to the diet in the approximate quantities required. For the first run of the 
optimiser enable the ME and MP constraints to ensure it is possible to calculate a diet from the feeds 
selected that meets the cow’s requirements. Once a feasible diet has been found progressively add 
additional constraints starting with your preferred intake estimate until you have a diet that meets your 
needs or the optimiser cannot find a feasible solution. This step-by-step approach is far more likely to result 
in an optimised diet than simply turning on all the constraints immediately. This is because if a feasible diet 
cannot be found you know it was the last constraint that is the issue and you can then either exclude that 
or relax other constraints until a feasible diet can be found. 

Remember, the optimiser simply treats the diet as a mathematical problem to solve and has no nutritional 
awareness. It can find a feasible diet that minimises cost and meets the constraints but that may harm your 
cows. Evaluate each feasible diet carefully. 

 

Figure 43.The Optimise tab. 

 

 



 

You can add constraints to control the diet content of NDF, eNDF, NDF supplied by forage, crude protein, 
forage concentrate ratio, kilograms of concentrate, starch, sugar and fat. For each of these constraints you 
must specify the minimum and maximum levels that are acceptable using the left and right sliders. The 
actual values will be displayed to the left of the slider. The narrower the range the less likely a feasible diet 
can be found. To make the constraint active click the box to the left of the constraint name to put a tick in 
it. 

The last three constraints, Ingredient 1, 2 and 3, refer to diet ingredients 1, 2 and 3. Using these you can 
specify the amount of each of the three feeds in the diet. The ‘F’ button enables you to fix an ingredient at 
the amount currently entered. This is useful when the amount of pasture available has been previously 
determined and can be fixed. Then the remainder of the diet ingredients that are supplements can be 
changed to optimise the diet. 

Figure 44. The Optimiser has been unable to find a feasible diet. 

 

 

When a feasible diet cannot be found check the diet detail tab to see how close the optimiser was to the 
specified level. This may give you a hint as to which constraint is preventing optimisation. You can then 
either add additional feeds or relax a constraint until a feasible diet is found. 
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Figure 45. Successful optimisation after relaxing the sugar constraint. 

 

 
  



 

COSTS, INCOME, EFFICIENCIES, AND MARGINS 

The bottom of the Rumen8 window displays a range of parameters that allow you to evaluate the financial 
performance of the current diet. All feeds in the diet must have a feed cost entered and a milk price is also 
required. 

Figure 46. The costs, income, efficiency and margin measures. 

 

 

These parameters are divided into four groups. From left to right they are feed costs, milk income, feed 
efficiencies and margins. The first two of the feed efficiency measures and the feed as a percent of income 
measure may also have a recommended level set in preferences to quickly show if they are within the 
recommended range via a small traffic light. 

The current milk yield can also be adjusted in the bottom right of the window allowing the animal 
performance to be fine-tuned while the Animal tab is not visible. 
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THE FEED LIBRARY EDITOR 
The feed library is accessible from the edit menu of the main Rumen8 window. It allows you to edit all the 
parameters for each feed and define commonly used mixes. The feed library window is divided into three 
tabbed sections, the first tab (Selection) shows all the feeds available in the library, the second (Mixes) 
allows creation of feed mixes and the last (Feeds) the details of every feed. 

Figure 47. The Selection tab of the feed editor. 

 

SELECTION 

The list of feeds in the left of the feed library window shows all the feeds and mixes available in the current 
library. Feeds with a tick in the box to the left of their name will be visible in the diet ingredient drop-down 
lists of the main Rumen8 window. This allows you to have a large feed library but only make a smaller more 
manageable number of feeds visible when creating diets.  

The right of the feed list shows the total number of feeds and the number currently visible in the diet 
ingredient drop-down lists. Below that the path to the current feed library is shown, which is useful if you 
are changing between the default feed library and user feed libraries.  

Select feeds 

The Select buttons allow you to select all, none, or invert the current selection of the feeds and mixes with 
a single click. Beneath those you can select all or none of just the feeds or just the mixes. 

Sort feeds 

The sort feeds buttons allow you to change the order of the feeds and mixes so they are listed in ascending 
or descending (reverse) order by name, category or if they are selected. 



 

Feed libraries 

You may have multiple feed libraries and switch between them. When Rumen8 starts, it will load the library 
used last time if it is still available. If not, it will revert to the default feed library. Feed libraries must be 
called Feed.db3 so you cannot have two libraries in a folder. 

The ‘Open user’ button allows you to open a user feed library from another folder on the disk. The ‘Create 
new’ button allows you to save a copy of the current library in a new folder. The ‘Use default’ button re-
loads the default feed library held in the ~\Rumen8\Libraries folder. There must always be a default library 
in the Libraries folder and if it is removed Rumen8 will replace it when it starts. 

If you have a user feed library loaded the UFL flag will also appear in the main window and the path to the 
feed library will be shown in flag’s tooltip (hover the mouse over it to see it). 

Figure 48. The user feed library flag in the main window (highlighted with a blue arrow). 
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Importing old feed libraries 

The Import button allows you to import an older Rumen8 feed library held in a feed.csv file. 

Figure 49. The import window of the feed editor. Barley grain is already present in the feed library. 

 

Select the feed.csv file to import and then the window shown above will appear. Rumen8 version 3 requires 
two additional categories for each feed, management category and particle size classification. You can step 
through each feed to be imported and provide these. If they can be determined from other feed 
information the importer will select them for you.  

Each feed must have a unique name so if the import feed name already exists the Name label will turn red 
and you must provide an alternative. 

Once the import feed has a unique name and the all three categories the Add button will become active so 
you can add it to the feed library. At any stage, you can click on the Skip button to ignore the current import 
feed and move to the next. Pressing Cancel will finish the feed importing. Feeds already added will remain 
in the feed library. 

 

  



 

MIXES 

The mixes tab lets you define commonly used mixes of feeds that can be selected as a single ingredient in 
a diet. 

Figure 50. The mixes editor in the feed editor. 

 

 

The left part of the window shows all the mixes in the feed library and the Edit section shows the details of 
the currently selected mix. You can use the buttons above the mix list to create, change, and delete mixes. 

Edit  Edit the parameters of the currently selected mix. 

Add Copy  Add a new mix to the library that is a copy of the currently selected mix. 

Add New  Add a new blank mix to the library. 

Delete  Remove the currently selected mix from the library. 

The Edit section becomes active when a mix is being created or changed. The feed list on the right shows 
all the feeds in the current feed library that are not in the mix. They can be added to the mix table singly or 
in groups by selecting them and clicking on the add (<) button. Multiple feeds can be selected by choosing 
the first one and then holding down the control key while clicking on subsequent ones. Groups of feeds 
can be moved into the mix by selecting the first feed and then holding down the shift key when selecting 
the last one. Alternatively, you can double click on a single feed to move it straight into the mix. 

To remove a feed from the mix, click on the row header in the mix table to highlight the row and press the 
remove (>) button. 

Once all the feeds have been moved into the mix table you must give each one a percentage on a dry 
weight basis. You cannot save the mix unless all the feed percentages add up to 100. The total at the bottom 
of the mix table shows the current percentage and will be red if it isn’t 100%. If the percentage is under or 
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over 100 the difference is shown in brackets. Change each feed percent by double clicking on the value in 
the table. 

Below the mix table are the remaining parameters needed to define a mix. The mix name must be unique 
among both feeds and mixes and will turn red if this is not the case. You will be unable to save the mix until 
it has a unique name. If you are unsure what the parameters are, hover your mouse over the name and a 
tooltip will appear with the full name. Abbreviations are also listed at the end of this document. 

If you enter an invalid value into the entry box for any of the parameters, the parameter name will turn 
red.  

 

FEEDS 

The Feeds tab lets you edit all the parameters for each of the feeds in the current library. The currently 
highlighted feed has its parameters displayed in edit section of the window. 

Figure 51. The mixes editor in the feed editor. 

 

 

Edit Edit the parameters of the currently selected feed. 

Add Copy Add a new feed to the library that is a copy of the currently selected feed. 

Add New Add a new blank feed to the library. 

Delete Remove the currently selected feed from the library. 

To edit an individual feed highlight it in the feed list and click the ‘Edit’ button. The entry boxes in the Edit 
section of the window will become active and allow you to change any of the feed parameters. 



 

As a minimum, eleven parameters are required for a feed to be accepted as valid and their names are in 
bold in the edit section. These are a unique name, management category, protein type, particle size 
classification, ME, CP, DM, Fat, aN, bN and cN. Until valid values for these parameters are entered you will 
be unable to save the feed. 

If you unsure what the parameters refer to, hover your mouse over the name and a tooltip will appear with 
the full name and an explanation. Abbreviations are also listed at the end of this document. 

If you enter an invalid value into the entry box for any of the parameters, the parameter name will turn 
red. Once you have entered all the feed parameters you have, or have edited an existing feed, click on the 
‘Okay’ button to save your changes and return to feed selection.  

Figure 52. Entering parameters for an individual feed. 

 

 

IMPORTANT 

Given the importance of the correct management category, protein type and particle size classification of 
a feed, and the difficulty in obtaining aN, bN and cN values for feeds, we strongly suggest you ALWAYS 
create a new feed in your feed library by adding a copy of a closely matching existing feed from the original 
Rumen8 feed library, which can then be modified for DM, ME, CP, fat and other feed values. For this reason 
we also suggest you NEVER edit feeds in the original Rumen8 feed library, but add copies of these feeds 
instead which can then be modified to reflect your feeds. 

Although Rumen8 can function with just these required parameters, to make full use of the features of the 
program, all feed values should be entered if possible. Entering feed costs and keeping these up to date is 
also important if you wish to compare diets to determine the lowest cost option. 

As the aN, bN, cN and ADIN values are not easily obtained, a generic list is provided here that indicates 
typical values for different feed classes (AFRC 1993). 
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Table 1. Typical protein degradability (aN, bN and cN) and ADIN (g/kg DM) values for different feed classes  

 

 

  

Feed class aN bN cN ADIN

Fresh forages 0.24 0.67 0.12 1.2

Roots 0.25 0.65 0.41 1.2

Grass and legume silages 0.59 0.31 0.13 1.2

Cereal silage incl maize 0.69 0.20 0.10 2.2

Grass hays 0.22 0.60 0.08 1.2

Legume hays 0.20 0.65 0.29 2.0

Cereal straws 0.30 0.50 0.12 1.0

Cereals 0.47 0.48 0.27 0.4

Legume seeds 0.41 0.57 0.16 0.5

Cereal byproducts 0.36 0.55 0.09 1.0

Beet and citrus pulps 0.39 0.57 0.05 1.2

Oils meals, high fibre 0.24 0.69 0.11 3.3

Oil meals, low fibre 0.14 0.79 0.09 2.1



 

PREFERENCES 
Access to the preferences window is via the Preferences option in the File menu of the main Rumen8 
window. The settings you can adjust in Rumen8 are divided into General, Recommended levels and 
Advanced tabs. 

 

GENERAL PREFERENCES 

Figure 53. The General preferences tab. 

 

 

Milk yield units Milk yield can be entered and reported in litres or 
kilograms. 

Milk component units The fat, protein and lactose percentage of milk can be 
entered and reported in mass/volume (kg/litre) or 
mass/mass (kg/kg) units (mm% or mv%). 
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Feed concentration units The units for concentration used by Rumen8 can be 
set to g/kg or percentage. 

Feed proportion units The units for parameters such as aN, bN or cN can 
entered and displayed as a proportion (0 to 1) or a 
percentage. 

Total solids ratio The total solids ratio displayed on the Animal tab can 
be shown as Fat: Protein or Protein: Fat. 

Tooltips detail This allows you to set the level of information 
provided by the tooltips. None turns tooltips off 
completely so there will be no additional information 
when you hover the mouse over an item. Standard 
provides a one line explanation and Extended 
provides the default longer explanations with 
diagrams. 

Dry matter intake estimate The animal’s feed intake potential can be estimated 
using the ‘maximum NDF as a percentage of live 
weight rule’ or the NRC (2001) calculation. The NRC 
calculation is the method we recommend for 
lactating cows receiving concentrate in their diet. 

Maximum NDF intake as a % of live weight Enter the percentage of live weight used for 
calculation of potential intake by the NDF method. 
The default is 1.2%.  

Show the diet tab The Diet tab can be turned off by un-ticking this box. 
Useful if you only use the Diet detail tab. 

Change the Rumen8 home directory after restart If you want to change where Rumen8 stores its files 
(usually ~\Documents\Rumen8) then clicking the 
‘Change home’ button will cause Rumen8 to ask you 
where to place the Rumen8 directory next time it is 
started. If this is a new directory the default feed 
library and preferences files will be copied across. If 
you wish to retain your existing library files you 
should copy them into the new location using 
Windows Explorer. 

Restore all the preferences to their default setting This will set all the preference settings back to their 
default values. 

Optimiser disabled/enabled The Optimiser tab will be available in the main 
window if this box is selected. This also makes 
available the Optimiser preferences below it. See the 
Optimiser section of this document for more 
information on using the optimiser as it requires 
Microsoft Excel and the Solver add-in along with 
careful setup. It will not work if you just enable it 
here! 



 

The Optimiser parameters 

Excel visible during optimization Tick this to see Excel load and optimise the diet. 
Usually left un-ticked. 

Excel saves diet after optimization Tick this to make Excel save the optimiser 
spreadsheet after optimising the diet. This is useful 
for debugging and is usually left un-ticked. 

 

ADVANCED PREFERENCES 

The advanced section of the preferences contains those settings that are unlikely to need adjustment and 
may have a significant impact on the cow nutrition model if they are changed. Please change them only in 
consultation with a highly experienced and qualified nutritionist. Or better, contact us to discuss the impact 
of the changes you are wanting to make. 

Figure 54. The Advanced preferences tab. 
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5% energy and protein safety margin Turn this on to add a 5% safety margin to the cow’s 
energy and protein requirement. Turning this on is 
recommended by the feeding standard. 

Gross energy in 1 kg of dry matter Enter the gross energy contained in 1 kilogram of dry 
matter in mega joules. Used as part of the cow energy 
requirement calculation. 

Fasting metabolism correction factor Rumen8 will increase the fasting metabolism energy 
requirement by multiplying it by this value. 

Fixed addition to ME requirement Rumen8 will add this value to the cow’s energy 
requirement. 

MP requirement correction The cow’s total protein requirement will be 
multiplied by this value. 

Excess protein removal cost The range of values for the cost of removing excess 
protein by the cow. A range is provided as there are 
differing values quoted in the literature, which vary 
depending on the degree of N recycling via saliva. 

Net energy for live weight change The net energy liberated by live weight loss or 
required for live weight gain. 

Cow time standing Leave at 14 hours unless you have access to a better 
estimate. 

Cow position changes The number of times a cow gets up or down during 
the day. Leave at 10 unless you have access to a 
better estimate. 

Milk true protein content The percentage of crude protein in milk that is true 
protein. 

Milk lactose The lactose content (%) of the milk for your cows. 

Weight of a litre of milk The weight of one litre of milk in kilograms. 

DCAD target levels The DCAD targets for early dry cows (dry off to 
entering the springer herd), ‘springers’ (transition 2 
weeks prior to calving) and lactating cows. 

Traffic light and progress bar accuracy These parameters set the sensitivity of the ‘traffic 
lights’ for the cow’s energy, protein, intake and 
minerals on the Diet detail tab and the progress bars 
in the Diet tab. The lights will show green if the diet 
provides an amount of energy, protein, dry matter 
intake or mineral that is within this percentage of the 
cow demand. 

 

  



 

RECOMMENDED LEVELS 

Rumen8 allows the user to set a recommended level range for several important diet parameters. These 
provide quick feedback on the suitability of the current level of a diet measure on the Diet and Diet detail 
tabs with a traffic light. Four sets of recommended levels can be defined and quickly switched between on 
the Diet detail tab. These could be used for early, mid and late lactation cow diets for example. 

Figure 55. The Recommended levels tab in Preferences showing example ranges for early lactation cows. 

 
 

Select the current recommended levels set by clicking on one of the buttons across the top of the tab. 
Describe the use of the set with a short description below. 

For each of the 14 diet measures you can set an acceptable range by moving the minimum and maximum 
sliders left or right. The actual values are displayed to the left of the slider. So, if you wish to target NDF 
levels of 28-30% in early lactation activate the NDF recommended levels by clicking on the checkbox to the 
left and then move the sliders until that range is displayed.  Now a traffic light will appear on the Diet and 
Diet detail tabs that will show you if the diet NDF level is below (red), within (green) or above (yellow) your 
recommended NDF level. Repeat this process for each of the diet measures for you wish to display a 
recommended level traffic light. 
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KEEPING RUMEN8 UPDATED 
Rumen8 can check for updates if your computer is connected to the Internet. Select ‘Check for updates’ 
under the Help menu and if an update is available a small blue information icon will appear above the 
Margin section of the main window. 

 

Figure 56. The information icon that means an update is available highlighted with a blue arrow. 

 

 

Clicking on the blue information icon will roll out a menu telling you the update will be installed the next 
time Rumen8 starts. If you click on this text a drop down menu gives you the choice to install the update 
now or view the changes in the new version. 



 

Figure 57. Installing an update or viewing changes. 

 

When Rumen8 is restarted, it will download the files required, update your installation of Rumen8 and then 
start the new version. The blue information icon will be replaced by a green tick which when clicked will 
confirm you have updated to the latest version. 

If you check for updates and there is not one available a green tick will appear above the Margin section of 
the main window and if you click on it, it will confirm you already have the latest version of Rumen8. 

Figure 58. You have the latest version of Rumen8. 
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Rumen8 will check for updates every day automatically if your computer has a connection to the Internet. 
The update system has been optimised for slow connections so it only downloads the file changes that are 
necessary, not the entire Rumen8 installation each time. 

If your computer is offline, you can download the latest version of Rumen8 from the website and then 
install the new version manually. Your library and diet files will not be changed when you do this. 

  



 

UNINSTALLING RUMEN8 
Completely removing Rumen8 from your computer will take three steps. 

1. Remove your registration information from the computer. 
Go to the Registration option under the Help menu and click the ‘Deregister’ button. Your details will 
be removed from the computer and Rumen8 will revert to trial mode. 
 

Figure 59. Removing the registration information from Rumen8. 

 

 

2. Uninstall the Rumen8 software. 
Go to the Windows Control Panel and in the ‘Programs’ section click on ‘Uninstall a program’ in 
Category view, or ‘Programs and features’ in icon view. Select Rumen8 from the list and click the 
‘Uninstall’ button at the top of the list. Follow the prompts and Rumen8 will be removed from your 
computer. 
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Figure 60. Uninstalling Rumen8 

 
 

3. Delete the Rumen8 folder from your Documents folder. 
If you do this you will lose your feed library, preferences and any saved diet files. 

 

4. (Optional) Delete the ‘Western_Dairy_Inc’ folder containing the settings files from the AppData\Local 
folder from within your user folder. This folder is normally hidden so this step is for advanced users 
only. These files only take up a tiny amount of disk space so this isn’t important. 

 

  



 

OPTIMISER INSTALLATION (ADVANCED USERS) 
The optimise function in Rumen8 is unsupported. This is because it requires communication with specific 
versions of Microsoft Excel and configuration is difficult. However, if you have a good knowledge of 
Microsoft Excel and Windows and would like to try, the steps for Excel 2016 are listed below. The process 
is very similar for Excel 2010 and 2013. 

Rumen8 only supports Microsoft Excel 2010, (version 14), 2013 (version 15) and 2016 (version 16) and it 
requires the Solver add-in to be installed. The animal model used by Rumen8 requires non-linear 
optimisation to estimate the lowest cost diet from the chosen ingredients and Solver provides this. 

Rumen8 copies the current diet into the Optimiser3.xlsm spreadsheet, configures Solver with the required 
constraints, runs it and then copies the results back into Rumen8. To do this the Optimise3.xlsm 
spreadsheet must have Excel macro security set correctly, the Solver add-in installed and a Visual Basic for 
Applications Reference added to give access to the local Solver file. The steps below show you how to do 
this. 

 

INSTALLATION INSTRUCTIONS FOR EXCEL 2016 

1. Open the Optimise.xlsm spreadsheet in the ~\Documents\Rumen8\libraries folder in Excel.   

Figure 61. Open the Optimise.xlsm spreadsheet. 

 

 

2. If Excel’s security level is still set to the defaults you will be prompted under the ribbon menu with a 
Security warning that macros have been disabled. Click on ‘Enable content’ in the message that 

appears.   If Excel’s security level is set too high, it will automatically and silently disable macros 
which will prevent Rumen8 from optimising diets.  
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Figure 62. Enable macros in the optimiser spread sheet. 

 

 

SET EXCEL SECURITY LEVELS 

3. To ensure the macros settings are correct we must go into the File menu. It is the left most menu on 
the ribbon.  

Figure 63. Click on the File ribbon menu to access Excel options. 

 



 

 

4. Click on the ‘Excel Options’ button at the bottom of the menu.   

Figure 64. Accessing Excel Options from the Excel menu. 

 
 

5. On the left side of the window click on the ‘Trust Centre’ and then the ‘Trust Center Settings’ button 
to enter the Trust center. 

Figure 65. Enter the Trust Centre in Excel. 
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6. Check that Macro Settings are set to ‘Disable all macros with notification’. If the macro security level 
is set higher than this Rumen8 will not be able to run the optimiser. Click on ‘Okay’ to exit the Trust 
Centre once you have finished. 

Figure 66. Enter the Trust Centre in Excel. 

 

 

INSTALL THE SOLVER ADD-IN 

7. Click on the ‘Add-Ins’ option on the left of the window and then set the Manage drop-down list at the 
bottom of the window to ‘Excel Add-Ins’ and click the ‘Go’ button. 

Figure 67. Enter the Add-ins manager. 

 



 

8. A list of possible Add-Ins appears in the new window. Click on the checkbox alongside ‘Solver Add-In’ 
to install it if it is not already selected. Click ‘Okay’ to install Solver and exit Options back to the 
spreadsheet. 

Figure 68. Install the Solver Add-In. 

 

 

9. Confirm Solver is correctly installed by ensuring ‘Solver’ is visible at the end of the ‘Data’ ribbon. 

Figure 69. Solver is visible at the end of the Data menu in the Ribbon. 
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ADD THE REFERENCE TO SOLVER IN THE VISUAL BASIC FOR APPLICATIONS EDITOR 

10. Click on the ‘View’ menu of the ribbon. The last option is called ‘Macro’, click on the drop-down menu 
and select ‘View macros’ from it. 

Figure 70. The Macro menu in the View ribbon. 

 

 

11. In the Macro window that opens select the macro ‘Sheet1.Solve’ and then click the ‘Edit’ button. 

Figure 71. Start the Visual Basic for Applications editor. 

 

 

  



 

12. In the Visual Basic Editor select ‘References’ from the ‘Tools’ menu. 

Figure 72. Open the Visual Basic for Applications References editor. 

 

 

13. Visual Basic for Applications also needs to know where to find the Solver add-in.  You may need to 
search down the list to find the Solver entry. When you first open the editor, it may be listed as 
missing. Even if it doesn’t say MISSING continue with the steps below. 

Figure 73. The Solver reference is missing in the Visual Basic for Applications References editor. 
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14. Click on the ‘MISSING: SOLVER.XLAM’ line and then the Browse button. At the bottom of the dialog 
box change the “Files of type” drop-down to show all files. 
Now navigate to the directory in which Microsoft Office has installed the solver files.   
 
For Office365 Excel 2016 this is usually the folder “C:\Program Files\Microsoft Office\Root\Office 
16\Library\SOLVER\”.  
If you are using an earlier version of Office the number 16 in the path will be lower, 15 for Office 2013 
for example. Standalone installations may not include the ‘Root’ folder part of the path. It is 
important to find the SOLVER.XLAM file used by the default version of Excel on your computer. 
 

Figure 74. The SOLVER folder for Office 365 Excel 2016. 

 

 
15. With ‘All Files’ selected SOLVER.XLAM should now be visible.  Select it and click on “Open”. 

Figure 75. The SOLVER folder for Office 365 Excel 2016. 

 
 
 

  



 

16. The Solver reference should no longer be listed as missing. Ensure it has a tick against it and click the 
‘Okay’ button to exit the window. 

Figure 76. Solver is installed correctly for Visual Basic for Applications. 

 

 
17. Save the Optimiser3.xlsm file buy selecting ‘Save Optimise3.xlsm’ from the File menu. 

Figure 77. Save the optimiser spreadsheet. 
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18. Exit back to the spreadsheet using the ‘File’ menu and the ‘Close and Return to Microsoft Excel’ 
option. 

19. Excel setup for use with Rumen8 optimisation is now complete so exit from Excel saving changes if 
you are prompted to do so. 

20. Rumen8 defaults to not allow access to the optimiser so the final step is to tell it you have configured 
Excel correctly.  In the Rumen8 Preferences General tab enable the Optimiser tab by clicking on the 
down arrow to the left of ‘Optimiser disabled’ at the bottom of the window. The Optimiser settings 
box will open and the title will change to ‘Optimiser enabled’. Both settings in the box should be left 
off for normal use.  

Figure 78. Setup the Rumen8 preferences to use the optimiser. 

 

 

Now when you return to the main Rumen8 window a new tab called ‘Optimiser’ will be available. 

 

  



 

OPTIMISER TROUBLESHOOTING  
If you have followed the setup instructions for the Optimiser and it fails when you try to optimise, the most 
likely problem is the VBA reference to the SOLVER.XLAM file. If this happens you will see the Visual Basic 
for Applications editor appear with an error message telling you it cannot compile because it cannot find a 
project or library (the SOLVER.XLAM file). 

Figure 79. Trying to optimise causes the VBA editor to appear with a compile error message. 

 

 

Close the error message by clicking on the ‘Okay’ button and then reset the macro by clicking on the Reset 
button in the toolbar. It is a square stop button in the style of VCR play, pause and stop buttons (see the 
figure below). 
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Figure 80. Reset the macro execution with the stop button in the toolbar. 

  

 

Now you can update the reference to the SOLVER.XLAM file as you did in the third part of the optimiser 
setup instructions starting with the References editor in the ‘Tools’ menu. 



 

Figure 81.Accessing the References editor in the VBA editor. 

 

 

From this point follow the instructions as you did when you originally set up the optimiser from step 12. 
The only difference is when you return to Rumen8 after saving your changes it will have an error message 
telling you it couldn’t start the Solver. Click ‘Okay’ and then try optimising again. 

 

Figure 82. The Rumen8 error message saying it could not start the Solver in Excel. 
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ABBREVIATIONS 
Abbreviation Units Description 

A MJ/d activity allowance 

ADIN g/kg DM acid detergent insoluble nitrogen 

aN  proportion of water soluble N in the total N of the feed 

Ash g/kg DM ash content of feed (after heating to 600 C for 10 hrs) 

Balance (MJ) MJ the difference between metabolisable energy 
requirements and supply 

bN  proportion of degradable N, other than water soluble 
N, in the feed 

Ca  Calcium 

Calcium g/kg or g/kg DM concentration of calcium in the diet  

Cl MJ/d plane of nutrition correction factor in calculating ME 
requirements 

cN  fractional rumen degradation rate per hour of the b 
fraction of the feed N with time 

Comp. 1 kg the amount of component 1 must fall within specified 
minimum and maximum values 

Comp. 2 kg the amount of component 2 must fall within specified 
minimum and maximum values 

Comp. 3 kg the amount of component 3 must fall within specified 
minimum and maximum values 

Con+By (kg) kg amount of concentrate and byproduct in the diet 

Conc. + ByPr. g the total amount of concentrate + byproduct in the 
diet must fall within specified minimum and maximum 
values 

Conc. + ByPr. g/kg the concentration of concentrate + byproduct in the 
diet must fall within specified minimum and maximum 
values 

Cost $/cow and c/MJ diet cost ($/cow and c/MJ) and margin ($/cow) 

Cost $/tonne cost to produce or buy 1 tonne of feed (nominate if 
wet or dry) 

Cost ($/t) $/tonne diet cost per tonne 

Cost (c/MJ) c/MJ diet cost on a metabolisable energy basis 

Cost A.L. DM $/tonne DM cost after losses on a dry matter basis 

Cost A.L. wet $/tonne wet cost after losses on a wet or fresh basis 
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Abbreviation Units Description 

CP g/kg the concentration of CP in the diet must fall within 
specified minimum and maximum values 

CP g/kg DM crude protein (N * 6.25) 

Days in milk d number of days the cow has been lactating 

Days pregnant d number of days the cow has been pregnant 

Distance walked m/d distance walked each day by the cow 

DM g/kg dry matter 

DMI kg and % dry matter intake (kg) and % of maximum intake 
(NDF/NRC methods) 

DMTP g digestible microbial true protein 

DUP g digestible undegraded protein 

Ec MJ/d net energy retained in concept (foetus and placenta 
etc) 

El MJ/d net energy secreted as milk 

Em MJ/d net energy for maintenance 

eNDF g/kg the concentration of effective NDF in the diet must fall 
within specified minimum and maximum values 

eNDF g/kg DM effective neutral detergent fibre 

eNDF (%) %DMI effective NDF in the diet 

ERDP  g effective rumen degradable dietary protein 

ERDP CP % percentage of the CP that is effective rumen 
degradable dietary protein 

   

Excess MP g MP in excess of requirements which will take ME to 
remove from the body  

Excess MP cost $?? the metabolic cost to remove excess metabolisable 
protein expressed as forgone weight change or milk 
production 

F MJ/d fasting metabolism 

fat g/kg the concentration of fat in the diet must fall within 
specified minimum and maximum values 

Fat g/kg DM Fat 

Feed ($/cow) $/cow/day feed cost 

FME MJ fermentable ME of the diet 

Height walked m/d height change during walk each day 



 

Abbreviation Units Description 

Intake (kg) kg the maximum DMI cannot exceed 100% as 
determined by live weight, milk yield and week of 
lactation 

Intake (max. NDF) g the maximum DMI cannot exceed 100% as 
determined by NDF intake and live weight 

Kc  efficiency of utilisation of ME for growth of the 
concepta 

Kg  efficiency of utilisation of ME for weight change when 
lactating 

Kl  efficiency of utilisation of ME for lactation 

Km  efficiency of utilisation of ME for maintenance 

Kt  efficiency of utilisation of mobilised tissue for lactation 

L MJ/d level of feeding as a multiple of MJ of ME for 
maintenance 

Limited by  factor limiting MP supply 

Live weight kg the cow’s live weight 

Live weight change kg/d cow’s daily live weight change 

Losses % dry matter loss from feed after costing 

Magnesium g/kg or g/kg DM concentration of magnesium in the diet 

Mg  Magnesium 

Margin ($/cow) $/cow/day margin (milk income - feed costs) 

Max DM Intake % % percentage of predicted maximum intake currently 
provided by the diet based on live weight, milk yield 
and stage of lactation 

Max MP cost MJ Maximum ME cost to remove excess MP 

Max NDF DMI % % percentage of predicted maximum intake currently 
provided by the diet based on NDF intake and live 
weight 

Mc  MJ/d ME requirement for growth of concepta 

MCP G microbial crude protein 

ME MJ metabolisable energy supplied and required 

ME MJ/kd DM metabolisable energy 

ME requirement MJ the diet must provide the ME required for 
maintenance and production 

Mg MJ/d ME requirement for live weight change when lactating 

Milk ($/cow) $/cow/day milk income 
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Abbreviation Units Description 

Milk fat % m/v percentage of milk that is fat 

Milk lactose % m/v percentage of milk that is lactose 

Milk protein % m/v percentage of milk that is true protein 

Milk yield L daily milk production 

Min MP cost MJ Minimum ME cost to remove excess MP 

Ml MJ/d ME requirement for milk production 

Mm MJ/d ME requirement for maintenance 

Mmp MJ/d ME requirement for maintenance and production 

MP g metabolisable protein 

MP balance g metabolisable protein balance 

MP min. requirement g the diet must provide an MP supply at least that 
required for maintenance and production 

MP required g the amount of metabolisable protein required for the 
production level 

MPb g/d basal endogenous nitrogen requirement 

MPc g/d MP requirement for the growth of the concepta 

MPd g/d dermal loss as scurf and hair 

MPg g/d MP requirement for live weight gain when lactating 

MPI g/d MP requirement for milk production 

MPm g/d MP requirement for maintenance 

MPmp g/d MP requirement for maintenance and production 

MTP g microbial true protein 

NDF g/kg the concentration of NDF in the diet must fall within 
specified minimum and maximum values 

NDF g/kg DM neutral detergent fibre 

NDF (%) %DMI neutral detergent fibre in the diet 

NDF (kg) kg total NDF in the diet 

NDF forage g/kg the concentration of NDF from forage in the diet must 
fall within specified minimum and maximum values 

NDF frge (%) %DMI NDF in the diet supplied from forages  

NFC (%) %DMI non fibrous carbohydrate in the diet 

Phosphorus g/kg or g/kg DM concentration of phosphorus in the diet 

P  Phosphorus 

Position changes no./d number of body position changes per day (lying down 
/ standing up) 



 

Abbreviation Units Description 

Protein g and % metabolisable protein supplied and required and 
crude protein % 

QDP g quickly degradable protein 

Qm  metabolisability of GE at maintenance 

r(fraction/hr)  rumen digesta fractional outflow rate per hour 

RDP g rumen degradable protein 

Required (MJ) MJ metabolisable energy supply required from the diet 
for specified production 

SDP g slowly degradable protein 

Source source of information FIM (feed information manual) / TFD (top fodder data) 
/ VMF (Vasse Milk Farmlets) / MvHS (M Staines data) / 
Protein Plus project etc. 

starch g/kg or g/kg DM the concentration of starch in the diet must fall within 
specified minimum and maximum values 

   

Starch (%) %DMI starch in the diet 

sugar g/kg or g/kg DM the concentration of sugar in the diet must fall within 
specified minimum and maximum values 

   

Sugar (%) %DMI sugar in the diet 

Time standing hr/d time cow spends standing each day 

Total (kg) kg total dry matter in the diet 

Total (MJ) MJ  total metabolisable energy supplied from the diet 

Total MP (g) g total metabolisable protein in the diet 

Type name other forage / grass silage / other silage / distillery 
product / other non-forage 

UDP g undegradable dietary protein 

y g potential microbial protein yield in the rumen from 
FME 

 

 


